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Create a Fillable PDF Form
Introduction

Designing fillable forms that can be completed and submitted online enhances usability for all 
users. By ensuring the form is accessible, you make it easier for individuals with disabilities 
to use and complete, fostering inclusivity, equal participation, and an improved overall user 
experience.
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Setting Up the Document Properties 
There are three parts to setting the basic document properites: 

1.	 Setting the Document Title
2.	 Setting PDF Metadata to Use the Document Title
3.	 Setting the Language in PDF

Performing these steps first when opening any PDF document will help resolve the most 
common errors before you start the remediation process.

Document Title

Setting the Document Title

First check if the document has a document title. If it doesn’t add the title. If the source 
document (such as Word, Excel, or PowerPoint) includes a title, the PDF will typically carry it 
over. Otherwise, you will need to add a title to the PDF. Follow the steps below to determine if 
the document title has been set properly.

Older Versions of Adobe Acrobat

1.	 Click on “File” at the top of the menu bar.

2.	 Select “Properties” to open the Document Properties window.
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Newer Versions of Adobe Acrobat

1.	 Click on “Menu” at the top left of the window.

2.	 Select “Document Properties” to open the Document Properties window.

3.	 View the Description tab to determine if the document has a title and/or if the title is an 
appropriate description of the document. If the title is accurate, proceed to next section. If 
the title is not there or is not accurate, proceed to step 4.

Note: Steps 3 and 4 are the same in both older and newer versions of Adobe Acrobat

4.	 If there is no title, or if the title does not provide an accurate description of the document 
click in the Title field and select any text in it. Type in the new accurate document title.
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Setting PDF Metadata to Use the Document Title

When adding a title to the document, the metadata must be updated to reflect the new 
document title instead of the file name.

Note: These steps are the same in both older and newer versions of Adobe Acrobat.

1.	 Make sure you are still in the Document Properties. See last section for guidance.
2.	 Click on the “Initial View” tab.

3.	 If the “Show” dropdown menu is set to “File Name” change this to “Document Title”
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Setting the Language in PDF

Screen reader technology will read the document to the user in the language set for the document. 
A document can only have one language setting. The steps to set the correct language in a PDF 
are:

Note: These steps are the same in both older and newer versions of Adobe Acrobat.

1.	 Click on the “Advanced” tab in the Document Properties window.

2.	 Choose the “Language dropdown” and change it to the correct language. In this case 
“English.”

3.	 Click the “OK button to save any changes to the PDF title or language.
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Newer Versions of Adobe Acrobat

Locating the Prepare Form Tool

The next step is to create the fillable form document. To do this add form fields to the 
document, such as text fields, checkboxes, or drop-down menus. Adobe Acrobat Pro can 
automate most of the creation of fillable form fields by using the Prepare Form tools. By following 
these steps, the Prepare Form tool can be used to create a fillable form. Remember to save 
regularly.

1.	 Click the “All Tools” tab if it is not displayed by default.

2.	 Scroll down and click on the Prepare a form tool.
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Converting the Document to a Fillable Form

Acrobat will automatically analyze the document to detect for any form files. If it recognizes any 
form fields, it will highlight them. Reviewing and editing these fields will be needed. 

Once the Prepare Form tool has been clicked it will indicate “Choose an option to create a form” 
dialog box will appear. 

1.	 Your document will already appear to be selected so click on the Create Form button to begin 
the process. Adobe will automatically add the fillable form fields into the document.

Allow a few moments for the tool to detect and add form fields to the document. Once it is done 
the document is now a fillable form with form fields to input information in.
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Extra Form Fields

Sometime extra form fields are created because the program may have detected something 
similar to a field in the document when it was not. It does occasionally happen, the best way to 
deal with these extra unnecessary form fields is to remove them.

1.	 Still on the Prepare Form tool right-click on the extra form field. 
2.	 Select the Delete option.

The extra form field is now deleted.

Editing and Adjusting Form Fields

After the Prepare Form tool has added the form fields, their properties can be adjusted. In the form field’s properties, 
you can edit/set the field’s name, appearance, validation, formatting, and other options. These require a manual 
process to be accomplished. There are no tools or shortcuts to edit the form fields.

Naming Form Fields

Providing a unique and descriptive name for each form field ensures that screen readers and 
other assistive technologies can properly identify and interpret the fields. This allows individual 
with visual impairments or disabilities to navigate and interact with the form effectively.  

Once the fields have been created, go through the document to see if the fields have been 
named correctly. Such as License No should be License Number.
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If the name of the form field is incorrect or appears odd change the name of the form field. 

1.	 Still in the Prepare Form tool right-click on the form field that’s name needs to be 
changed.

2.	 Select the Properties option.

3.	 The Text Field Properties box will appear. This is where to edit the form field.
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4.	 Make sure you are in the “General” tab.

5.	 Find where it says “Name.” There is an input type box with the form fields name that 
needs to be changed. In this example Name is License No.
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6.	 Click inside the Name input type box and type in License Number instead.

7.	 Then click on the Tab button on the keyboard, this ensures that the name change will be 
saved.

Tooltip in Form Fields

Tooltip is a feature that allows additional information or instructions for the form fields. It can 
provide additional context or clarification about the purpose or expected input for a specific 
form field. It’ll help users understand what information is required or how they should interact 
with the field, reducing confusion and potential errors. 

1.	 Still in both the Text Field Properties box and General tab find the input type box called 
“Tooltip.” 

2.	 Click inside the Tooltip input box.

3.	 Type the description or the instructions of the form field. In this example the form field’s 
tooltip should be Enter License Number. Press the Tab button on the keyboard, to ensure 
that the changes are saved.
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4.	 Click on the Close button of the Text Field Properties.

Now clear instructions can be read from the form fields’ tooltip.	

Insert a Date Picker in Form Fields

Using a date picker in a form field will provide a user-friendly way for people to input dates 
accurately. It eliminates the need for users to manually type the date, reducing the chances of 
errors and ensuring consistency in the form. To add a date picker in a form field, follow these 
steps:

Still be in the Prepare Form tool, so that changes can be made to any of the form fields.

1.	 Select a form field that requires a date. Right click on the form field.

2.	 Select Properties.
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3.	 The Text Field Properties box will appear. Click on the Format tab. 

4.	 Click the “Select format category” drop-down menu. Change “None” to the “Date” option.



Page 15 

5.	 After selecting, the Date Options section will appear on the Format tab. It’ll show how the 
date will be displayed in the form field once the information is entered by users.

6.	 Select a date option such as mm/dd/yyyy.  The Example of current format section shows 
how the date will be displayed in the form field once the information is entered by users.
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7.	 Click on Close button at the bottom right of the Text Field Properties box.

Now when interacting with the form field, users will be able to select a date using the date 
picker. Remember that this date picker will help those who may have difficulty to select a date 
manually typing dates it allows to select a date visually instead. Enhancing usability for those 
with motor disabilities or visual impairments. 

Creating a Button for a Fillable Document

Buttons are important for user interaction of a fillable form document. Creating submit and 
reset form buttons are important to facilitate user interaction, prevent errors, meet user 
expectations, guide form to completion and ensure accessibility.  

Create a Submit Form Button

Providing a submit button allows users to indicate easily and clearly the submitting of the form. 
The presence of a submit button signals to users they completion of the form and is ready to 
submit.  It will provide a straightforward way for users to finalize the form and send the data for 
processing.

While still in the Prepare Form tool follow the instructions below:

1.	 Locate the additional tools under the Prepare Form Tool on the left side of the screen.
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3.	 Move the cursor to the spot where you want to add the button. While going to that area a 
blue rectangle will appear. Position the cursor where the submit button will be added.

2.	 the “Button” option in the Prepare Form tool panel to create a button.
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4.	 Click and drag to draw a rectangular button area on the form. The button will be given the 
default name Button1 (depending on how many buttons you’ve added to the form). 

5.	 Right click on the button and select Properties from the drop-down menu. 

6.	 The Button Properties box will appear. Note: the button number will depend on how many 
buttons have been made in the document.
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7.	 Click on the General tab, if it is not selected by default.

8.	 In the Name type input box rename ButtonX to “Submit Form Button”.
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9.	 In the Tooltip input type box enter the instructions “Submit Form Button”.

Labeling the Submit Button

Now creating a label for the Submit Form Button needs to be done. The button on the fillable 
form document will appear blank to all users, only those using screen or document readers will 
know what the button is. Making the document inaccessible to visual users. To make sure that 
all users know what kind of button it is follow these steps:

1.	 Go to “Option” tab.
2.	 Find the “Icon and Label” section of the Options tab.
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3.	 Find the Label input type box. Type the Label of the Submit Form Button as Submit Form.

Now the button will have the label Submit Form on it for the visual users.

Create a Submit Action for Button

The button has been created, given a label and name now it is time have it be able to submit 
the form. To do this the button needs to be given an action, so that the form knows that when 
this button is selected this action will be performed in this case the submit a form action. Follow 
these steps to ensure that submitting of the form will be accomplished:

4.	 Go to the “Actions” tab in Button Properties.
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5.	 Locate the “Select Action” section of the “Add an Action” panel of the Actions tab and 
select the “Submit a form” option.

6.	 Click on the “Add” button.

7.	 The Submit Form Selections box will appear.
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8.	 Enter the URL or email address where the form data should be sent upon submission in 
“Enter a URL for this link:” input type box.

9.	 Click on the Ok button. It’ll go back to the Button Properties box in the Action tab.
10.	 Find the Actions section of the Action tab. It’ll show what action will be taken in this case 

the Submit a form action will be applied when the mouse is click up.
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11.	 Click on Close button.
12.	 Close out of the Prepare Form tool by clicking the back button next to Prepare a form.

13.	 View the final version of the Submit Form button by clicking on the Submit Form button 
that was created.

14.	 A send Email Box will appear.
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15.	 Leave Send Using on “Default email application”, check the check box for “Remember my 
choice and click Continue.”

16.	 Now an email in the default email application will appear.

17.	 Make sure that the email address that appears in the To field is valid. Else it will not work 
and will not be sent correctly. 

The email will be sent to the address that was typed into the  
“Enter a URL for this link” (Step 5 of this procedure) input type box in Adobe Acrobat.
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18.	 Subject line will be the File name of the document, and the form will be attached to the 
email.

19.	 Then click the Send button

This form will appear in the email address that it was instructed to. Double check to see if it 
worked.

Now a Submit Form button has been added to the form document. Allowing the users to submit 
the entered information of the form data to be sent to the specified destination.
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Create a Reset Form Button

Providing a reset button error prevention before submitting document. Reset button gives users 
the ability to clear the form and start over if corrections are needed. It helps prevent errors 
by allowing users to easily undo field entries. While still in the Prepare Form tool follow these 
instructions:

1.	 Locate the Prepare Form tools and click the “Button” option to create a button.

2.	 Click and drag to draw a rectangular button area on the form. The button will be given the 
default name Buttonx (depending on how many buttons you’ve added).
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3.	 Move the cursor to the spot that the button will be added. While going to that area a blue 
rectangle will appear. Position the cursor where the submit button will be added.

4.	 Right click on the button and select Properties.

5.	 The Button Properties box will appear. Make sure you are in the General tab.

6.	 In the Name type input box rename Button2 to Reset a Form Button and in the Tooltip 
field type “Click to Reset form”.
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Labeling the Reset Form Button

Now creating a label for the Reset Form Button needs to be done. The button on the fillable 
form document will appear blank to all users, only those using screen or document readers will 
know what the button is, making the document inaccessible to visual users. To make sure that 
all users know what kind of button it is follow these steps:

1.	 Click on the “Option” tab.

2.	 Enter “Reset Form” in the Label input type box in the “Icon and Label” section of the 
Options tab.

Now the button will have the label Reset Form button on it for the visual users.
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Create a Reset Action for Button

The button has been created, given a label and name, and now it is time have it be able to 
reset the form. To do this the button needs to be given an action, so that the form knows that 
when this button is selected this action will be performed in this case the reset a form action. 
Follow these steps to ensure that resetting of the form will be accomplished:Go to the “Actions” 
tab in Button Properties.

1.	 Click the Actions tab and under the Add an Action section, click on the Select Action drop-
down menu and choose “Reset a form” from the options list.

2.	 Click on the “Add” button.

3.	 The Reset a Form dialog box will appear. In the “Select Fields to Reset” section there is a 
checkbox with different form fields that are on the document. Note:  Leave all the form 
fields check marked. Doing so will ensure that when the form is reset all those fields will 
have the previous data entered erased, then click OK.
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4.	 It’ll return to the Actions tab in the Button Properties. Find the Actions section. When 
Mouse is Up the action Reset a Form will be activated. Then click the Close Button.

5.	 Now back to the form document. Close out of the Prepare Form tool by clicking the back 
button to the left of Prepare a form.
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6.	 View the final version of the Reset Form button. 

*Add some information to any of the form fields. Click on the Reset Form button to see if it 
erases the data. If it does the action works. *

Now a Reset Form button has been added to the form document. Allowing the users to reset the 
entered information of the form data to be sent to the specified destination.
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Older Versions of Adobe Acrobat

Locating the Prepare Form Tool

Next step is to create the fillable form document. To do this add form fields to the document, 
such as text fields, checkboxes, or drop-down menus. Adobe Acrobat Pro can automate most of 
the creation of fillable form fields by using the Prepare Form tools. By following these steps, will 
have the Prepare Form tool be able to create a fillable form. Remember to save regularly.

1.	 Click the Prepare Form Tool on the right of the document.

If you don’t see the Prepare Form tool in the Tools Shortcuts,  
follow the procedure for Adding the Accessibility Panel to the Tools Shortcut Menu

http://ada.nv.gov/uploadedFiles/adanewnvgov/content/home/features/ADAClasses/AddingAccessibilityPanelToToolsMenu.pdf
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Converting the Document to a Fillable Form

Acrobat will automatically analyze the document to detect for any form files. If it recognizes any 
form fields, it will highlight them. Reviewing and editing these fields will be needed.

Once the Prepare Form tool has been clicked on the left side of the tool it will ask what file will 
be changed into a fillable form document.

1.	 It’ll already appear to be selected so click on the Start button to begin the process. Adobe 
will automatically throw in those fillable form fields into the document.

2.	 Allow a few moments for the tool to detect and add form fields to the document. Once it is 
done the document is now a fillable form with form fields to input information in.

Extra Form Fields

Sometime extra form fields are created because the program may have detected something 
similar to a field in the document when it was not. It does occasionally happen, the best way to 
deal with these extra unnecessary form fields is to remove them.

1.	 Still on the Prepare Form tool select the extra form filed. Right click on the field.
2.	 Select the Delete option.

The extra form field is now deleted.
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Editing and Adjusting Form Fields

After the Prepare Form tool has added the form fields, their properties can be adjusted. In the 
form field’s properties, you can edit/set the field’s name, appearance, validation, formatting, 
and other options. These require a manual process to be accomplished. There are no tools or 
shortcuts to edit the form fields.

Naming Form Fields

Providing a unique and descriptive name for each form field ensures that screen readers and 
other assistive technologies can properly identify and interpret the fields. This allows individual 
with visual impairments or disabilities to navigate and interact with the form effectively.  

Once the fields have been created, go through the document to see if the fields have been 
named correctly. Such as License No should be License Number.

If the name of the form field is incorrect or appears odd change the name of the form field. 

1.	 Still in the Prepare Form tool right-click on the form field that’s name needs to be 
changes.

2.	 Select the Properties option.
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3.	 The Text Field Properties box will appear. This is where to edit the form fields.

4.	 Make sure you are in the “General” tab.
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5.	 Find where it says “Name.” There is an input type box with the form fields name that 
needs to be changed. In this example Name is License No.

6.	 Click inside the Name input type box and type in License Number instead.

7.	 Then click on the Tab button on the keyboard, this ensures that the name change will be 
saved.
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Tooltip in Form Fields

Tooltip is a feature that allows additional information or instructions for the form fields. It can 
provide additional context or clarification about the purpose or expected input for a specific 
form field. It’ll help users understand what information is required or how they should interact 
with the field, reducing confusion and potential errors. 

1.	 Still in both the Text Field Properties box and General tab find the input type box called 
“Tooltip.” 

2.	 Click inside the Tooltip input box.

3.	 Type the description or the instructions of the form field. In this example the form field’s 
tooltip should be Enter License Number. Press the Tab button on keyboard, to ensure that 
the changes are saved.

4.	 Click on the Close button of the Text Field Properties.

Now clear instructions can be read from the form fields’ tooltip.	
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Insert a Date Picker in Form Fields

Using a date picker in a form field will provide a user-friendly way for people to input dates 
accurately. It eliminates the need for users to manually type the date, reducing the chances of 
errors and ensuring consistency in the form. To add a date picker in a form field, follow these 
steps:

Still be in the Prepare Form tool, so that changes can be made to any of the form fields.

1.	 Select a form field that requires a date. Right click on the form field.

2.	 Select Properties.

3.	 The Text Field Properties box will appear. Click on the Format tab. 
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4.	 Click the to the “Select format category” drop-down menu. Change “None” to the “Date” 
option.

5.	 After selecting, the Date Options section will appear on the Format tab. It’ll show how the 
date will be displayed in the form field once the information is entered by users. 
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6.	 Select a date option such as mm/dd/yyyy. To see the different appearances of the date 
options is to go to where it says, “Example of current format.” It is below the date 
appearance options.

7.	 Click on Close button at the bottom right of the Text Field Properties box.

Now when interacting with the form field, users will be able to select a date using the date 
picker. Remember that this date picker will help those who may have difficulty to select a date 
manually typing dates it allows to select a date visually instead. Enhancing usability for those 
with motor disabilities or visual impairments. 
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Creating a Button for a Fillable Document

Buttons are important for user interaction of a fillable form document. Creating a submit 
and reset form buttons are important to facilitate user interaction, prevent errors, meet user 
expectations, guide form to completion and ensure accessibility.  

Create a Submit Form Button

Providing a submit button allows users to indicate easily and clearly the submitting of the form. 
The presence of a submit button signals to users they completion of the form and is ready to 
submit.  It will provide a straightforward way for users to finalize the form and send the data for 
processing.

While still in the Prepare Form tool follow these instructions depending on whether you are user 
an older or newer version of Adobe Acrobat:

1.	 Locate the additional tools using the Prepare Form Tool. On the top of the document there 
are more tools while using the Prepare Form tool. 

2.	 Select the “Add a” option to create a button.

3.	 Move the cursor to the spot that the button will be added. While going to that area a blue 
rectangle will appear. Position the cursor where the submit button will be added.

4.	 Click and drag to draw a rectangular button area on the form. The button will be given the 
default name Button1. 
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5.	 Right click on the button and select Properties from the drop-down menu. 

6.	 The Button Properties box will appear. Note: the button number will depend on how many 
buttons have been made in the document.
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7.	 Click on the General tab, if it is not selected by default.

8.	 In the Name type input box rename ButtonX to “Submit Form Button”.

9.	 In the Tooltip in the input type box enter the instructions “Click to Submit Form”.
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Labeling the Submit Button

Now creating a label for the Submit Form Button needs to be done. The button on the fillable 
form document will appear blank to all users, only those using screen or document readers will 
know what the button is. Making the document inaccessible to visual users. To make sure that 
all users know what kind of button it is follow these steps:

1.	 Go to “Option” tab.
2.	 Find the “Icon and Label” section of the Options tab.

3.	 Find the Label input type box. Type the Label of the Submit Form Button as Submit Form.

Now the button will have the label Submit Form on it for the visual users.
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Create a Submit Action for Button

The button has been created, given a label and name now it is time have it be able to submit 
the form. To do this the button needs to be given an action, so that the form knows that when 
this button is selected this action will be performed in this case the submit a form action. Follow 
these steps to ensure that submitting of the form will be accomplished:

1.	 Go to the “Actions” tab in Button Properties.

2.	 Locate the “Select Action” section of the “Add an Action” panel of the Actions tab and 
select the “Submit a form” option.

3.	 Click on the “Add” button.
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4.	 The Submit Form Selections box will appear.

5.	 Enter the URL or email address where the form data should be sent upon submission in 
“Enter a URL for this link:” input type box.

6.	 Click on the Ok button. It’ll go back to the Button Properties box in the Action tab. 
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7.	 Find the Actions section of the Action tab. It’ll show what action will be taken in this case 
the Submit a form action will be applied when the mouse is click up.

8.	 Click on Close button.
9.	 Close out of the Prepare Form tool by click the Close button.
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10.	 View the final version of the Submit Form button by clicking on the Submit Form button 
that was created.

11.	 A send Email Box will appear.
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12.	 Leave Send Using on “Default email application”, check the check box for “Remember my 
choice and click Continue.”

13.	 Now an email in the default email application will appear.

14.	 Make sure that the email address that appears in the To field is valid. Else it will not work 
and will not be sent correctly. 

The email will be sent to the address that was typed into the  
“Enter a URL for this link” (Step 5 of this procedure) input type box in Adobe Acrobat.
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15.	 Subject line will be the File name of the document, and the form will be attached to the 
email.

16.	 Then click the Send button

This form will appear in the email address that it was instructed to. Double check to see if it 
worked.

Now a Submit Form button has been added to the form document. Allowing the users to submit 
the entered information of the form data to be sent to the specified destination.
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Create a Reset Form Button

Providing a reset button error prevention before submitting document. Reset button gives users 
the ability to clear the form and start over if corrections are needed. It helps prevent errors 
by allowing users to easily undo field entries. While still in the Prepare Form tool follow these 
instructions:

1.	 Locate the Prepare Form tools and select the “Add a” option to create a button.

2.	 Click and drag to draw a rectangular button area on the form. The button will be given the 
default name Buttonx (depending on how many buttons you’ve added).

3.	 Move the cursor to the spot that the button will be added. While going to that area a blue 
rectangle will appear. Position the cursor where the submit button will be added.

4.	 Right click on the button and select Properties.
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5.	 The Button Properties box will appear. Make sure you are in the General tab.

6.	 In the Name type input box rename Button2 to Reset a Form Button and in the Tooltip 
field type “Click to Reset form”.

Labeling the Reset Form Button

Now creating a label for the Reset Form Button needs to be done. The button on the fillable 
form document will appear blank to all users, only those using screen or document readers will 
know what the button is, making the document inaccessible to visual users. To make sure that 
all users know what kind of button it is follow these steps:

1.	 Go to “Option” tab.
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2.	 Enter “Reset Form” in the Label input type box in the “Icon and Label” section of the 
Options tab.

Now the button will have the label Reset Form on it for the visual users.

Create a Reset Action for Button

The button has been created, given a label and name, and now it is time have it be able to 
reset the form. To do this the button needs to be given an action, so that the form knows that 
when this button is selected this action will be performed in this case the reset a form action. 
Follow these steps to ensure that resetting of the form will be accomplished:Go to the “Actions” 
tab in Button Properties.

1.	 Click the Actions tab and under the Add an Action section, click on the Select Action drop-
down menu and choose “Reset a form” from the options list.
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2.	 Click on the “Add” button.

3.	 The Reset a Form dialog box will appear. In the “Select Fields to Reset” section there is a 
checkbox with different form fields that are on the document. Note:  Leave all the form 
fields check marked. Doing so will ensure that when the form is reset all those 
fields will have the previous data entered erased, then click OK.
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4.	 It’ll return to the Actions tab in the Button Properties. Find the Actions section. When 
Mouse is Up the action Reset a Form will be activated. Then click the Close Button.
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5.	 Now back to the form document. Close out of the Prepare Form tool.

6.	 View the final version of the Reset Form button. 

*Add some information to any of the form fields. Click on the Reset Form button to see if it 
erases the data. If it does the action works. *

Now a Reset Form button has been added to the form document. Allowing the users to reset the 
entered information of the form data to be sent to the specified destination.
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